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About This Guide

This guide documents the IRISconsole™ software graphical user interface for a Silicon
Graphics® 02™ or IndyTM workstation that allows it to control OriginTM, CHALLENGE®,
OnyXZTM, and Onyx® systems. The IRISconsole software is included in the base
IRISconsole option, which includes an IRISconsole ST-1600 or ST-1616 multiplexer. Serial
cables, which are specific to the type of system controlled, are provided by additional
IRISconsole options and complete the IRISconsole package.

The O2 or Indy workstation communicates with the servers through the multiplexer, to
which each Origin, CHALLENGE, or Onyx system is connected via a pair of serial cables.
Each multiplexer has ports for eight or more Origin, CHALLENGE, and Onyx systems;
additional sets of serial cables are available from Silicon Graphics. Optionally, an
additional multiplexer can be connected to the workstation to monitor additional
servers.

This guide was prepared in conjunction with Release 1.2 of IRISconsole.

This guide is written for system administrators and service personnel who are
responsible for the configurations of two or more Origin, CHALLENGE, or Onyx
systems that the IRISconsole controls and monitors. These persons can use the
IRISconsole software to monitor the attached systems.



About This Guide

Structure of This Document

This guide contains the following chapters and appendixes:

= Chapter 1, “IRISconsole Features and Capabilities,” introduces IRISconsole features
and describes how IRISconsole works with Origin, CHALLENGE, and Onyx
systems. This chapter explains how to use the IRISconsole security feature.

= Chapter 2, “Configuring IRISconsole,” describes how to set up IRISconsole software
in preparation for configuring and administering groups of systems.

= Chapter 3, “Configuring Sites,” explains how to use the IRISconsole graphical user
interface to set up groups of systems for administration purposes.

= Chapter 4, “Administering Sites,” explains how to use the IRISconsole graphical
user interface for administration tasks such as determining hardware status
(voltage, operating temperature, and blower speeds), and controlling, shutting
down, or restarting systems in a site.

= Appendix A, “Error Messages and Warning Messages,” lists and explains
IRISconsole error and warning messages.

An index completes this guide.

Font Conventions Used in This Guide

These font conventions are used in this guide:

Italics Executable names, filenames, IRIX commands, manual or book titles,
new terms, program variables, tools, utilities, variable command line
arguments, variable coordinates, and variables to be supplied by the
user in examples, code, and syntax statements

Fixed-width type
Error messages, prompts, and onscreen text

Bold fixed-width type
User input, including keyboard keys (printing and nonprinting); literals
supplied by the user in examples, code, and syntax statements



Chapter 1

IRISconsole Features and Capabilities

This chapter introduces the operational features and capabilities of the IRISconsole
software. The major sections in this chapter are as follows:

« “IRISconsole Hardware Configuration” on page 1
« “IRISconsole Graphical User Interface” on page 4
= “IRISconsole Security” on page 5

= “Overview of IRISconsole Operation” on page 5

IRISconsole Hardware Configuration

The IRISconsole software allows an O2 or Indy workstation to control Origin200,
Origin2000, CHALLENGE, Onyx2, and Onyx systems through one or two Silicon
Graphics ST-1600 or ST-1616 multiplexers. Serial cables that are ordered as separate the
IRISconsole option products connect the Remote System Control port and the System
Console port on each server to the multiplexer.

IRISconsole includes a security feature that lets you specify administrators and users
who will have access to the functions of IRISconsole. Also, certain features of IRISconsole
can be accessed remotely using ictelnet, a version of telnet that works with IRISconsole.

IRISconsole is a local system; the IRISconsole software applies only to systems that are
physically attached to the multiplexer connected to the O2 or Indy workstation on which
the IRISconsole software is running. The IRISconsole software cannot communicate with
another system running IRISconsole to share access to attached systems.

Cabling the multiplexer and Origin, CHALLENGE, Onyx2, and Onyx systems is
explained in the IRISconsole Multiplexer Installation Guide (007-2839-nnn). Figure 1-1
shows an example IRISconsole site installation.
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N

IRISconsole Site Example

Figure 1-1



IRISconsole Commands

Hardware requirements for the IRISconsole software are as follows:

IRISconsole Commands

The 24-bit O2 or Indy workstation must have a minimum of 32 MB of memory and
must be running IRIX 6.2 or 6.3. The 20-inch display is strongly recommended for
IRISconsole operation, as are XFS filesystems, for their decreased recovery time and
typically better performance.

If one of the attached servers is a CHALLENGE S, or if an attached CHALLENGE
or Onyx system does not have a Remote System Control port, not all features of the
IRISconsole software are available. An upgrade consisting of an RS-232 plate
assembly is available to equip CHALLENGE L servers that lack this port; contact
your service representative.

Only cables ordered as IRISconsole options are supported for connecting the Origin,
CHALLENGE, Onyx2, and Onyx systems to the multiplexer. The IRISconsole
Multiplexer Installation Guide describes these cables.

The IRISconsole software includes two commands, icpass and ictelnet, that are shell
commands for administering and using IRISconsole. The third IRISconsole command is
ic, which brings up a graphical user interface. It is described in the next section,
“IRISconsole Graphical User Interface.”

icpass is used for setting up and maintaining administrator and user logins, each with a
password. These logins and passwords are specific to IRISconsole and are independent
of system logins and passwords. Using icpass, you can

determine whether IRISconsole security is off or on
add an IRISconsole administrator

add an IRISconsole user

change the administrator’s or user’s password
delete an administrator or user

set IRISconsole security off or on

view a list of IRISconsole users

Using icpass is described in Chapter 2, “Configuring IRISconsole,” and Chapter 4,
“Administering Sites.”
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You can use the command ictelnet, which is a version of telnet adapted for IRISconsole, to
access the IRISconsole text-based menu from another system.

Preparing the IRISconsole O2 or Indy system for using ictelnet is described in the section
“Setting Up IRISconsole for Remote Access” in Chapter 2. Using ictelnet is described in
the section “Connecting to a Remote IRISconsole Workstation” in Chapter 4.

IRISconsole Graphical User Interface

The IRISconsole graphical user interface (GUI) enables you to set up and administer sites.
A site is a group of workstations, servers, or other systems that are administered through
IRISconsole.

The command that invokes the IRISconsole GUI is called ic. You can use the IRISconsole
GUI to

set up a site or add or delete the systems in a site
display, view, or take control of the console of a system

generate a nonmaskable interrupt (NMI), perform a hardware reset, or power cycle
a system

Note: System controllers on Origin and Onyx2 systems have passwords, which are
different from IRIX login passwords. In this release of IRISconsole, generating an
NMI, performing a hardware reset, and power cycling a system require that system
controller passwords have their default values.

view activity logs and other system reports

connect to the system controller on an Origin or Onyx2 system and issue system
controller commands

view real-time graphs of hardware operating statistics of a system in a site, such as
voltage, operating temperature, and blower speeds; save the graphs as files and
display them (this feature is not available on Origin and Onyx2systems)

set a threshold for operating statistics so that an alarm is activated and various
activities are triggered when the threshold is exceeded (this feature is not available
on Origin and Onyx2 systems)

Chapter 3, “Configuring Sites,” and Chapter 4, “Administering Sites,” in this guide
explain how use the IRISconsole GUI to set up sites and administer sites, respectively.



IRISconsole Security

IRISconsole Security

IRISconsole includes security features that use local password protection to assist
administrators in securing IRISconsole and its managed systems from unauthorized
access. When IRISconsole security is turned on (the default), access to certain operations
is controlled. Some of these operations are represented by buttons in the site window of
the IRISconsole GUI. The operations that are controlled when security is turned on are as
follows:

= adding or deleting sites and systems in the sites (Edit pulldown menu)

= getting the console (Get Console), viewing the console window of a system
controlled by another user (Spy Console), and taking control of a system console that
another user is currently using (Steal Console)

= generating a non-maskable interrupt (Generate NMI)
= performing hardware reset (HW Reset) and power cycle (Power Cycle)
= viewing console activity logs (Show Console Logs)

Note: Generate NMI, HW Reset, and Power Cycle on Origin and Onyx2 systems require
that the system controllers on those systems have default passwords.

Checking the current security setting and changing it are described in the sections
“Determining Whether IRISconsole Security is On or Off” and *“Setting IRISconsole
Security On or Off” in Chapter 2.

Overview of IRISconsole Operation

The installation and operation of IRISconsole consists of these major steps:

1. Install the multiplexer hardware and cable it to the O2 or Indy workstation and the
systems you plan to control. See the IRISconsole Multiplexer Installation
Guide for instructions.

2. Install the IRISconsole software and configure it: specify administrators and users,
choose the security setting, identify multiplexer port numbers, and prepare for
remote access. See Chapter 2, “Configuring IRISconsole,” for instructions.
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3. Specify sites, groups of workstations, servers, or other systems that are to be
administered through IRISconsole. See Chapter 3, “Configuring Sites,” for
instructions.

4. Use the features of the IRISconsole graphical user interface to administer the sites.
See Chapter 4, “Administering Sites,” for details.
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Configuring IRISconsole

This chapter describes various tasks that you must perform to install and perform the
initial configuration of IRISconsole software. The major sections in this chapter are as
follows:

« “Installing IRISconsole Software” on page 8

= “Adding an IRISconsole Administrator” on page 9

< “Adding an IRISconsole User” on page 10

= “Determining Whether IRISconsole Security is On or Off” on page 11
« “Setting IRISconsole Security On or Off” on page 11

« “Obtaining the Multiplexer SCSI ID Number and Serial Port Connections” on
page 12

= “Setting Up IRISconsole for Remote Access” on page 13



Chapter 2: Configuring IRISconsole

Installing IRISconsole Software

To install IRISconsole software, install these subsystems:

eoe.sw.uucp
UUCP software required by IRISconsole software.

sgitcl_eoe.sw.base
Tel toolkit software required by IRISconsole software.

sgitcl_eoe.sw.tm
Tel toolkit software required by IRISconsole software.

ST16xx.sw.base
Multiplexer software.

ST16xx.man.man
Reference pages for multiplexer software.

ST16xx.man.relnotes
Release notes for multiplexer software.

IRISconsole.sw.base
IRISconsole base software.

IRISconsole.sw.remoteaccess
IRISconsole software for remote access.

IRISconsole.sw.tcllink
IRISconsole Tcl software.

IRISconsole.man.man
Reference pages for IRISconsole software.

IRISconsole.man.relnotes
IRISconsole release notes.

IRISconsole.books.IRISconsole_ AG
This guide.

IRISconsole.books. MUX _IG
The IRISconsole Multiplexer Installation Guide.
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Adding an IRISconsole Administrator

To add an IRISconsole administrator, type as root

icpass -add icadmin

The window shown in Figure 2-1 appears.

Please enter the new adminlstrator’s Ingln and password,
then click "Apply™ to add to the databas

Password:

| e

Figure 2-1 Adding an IRISconsole Administrator

Enter the new user’s login and password. Note that they are independent of that user’s
system login and password. Click the Apply button.
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Adding an IRISconsole User

10

To add an IRISconsole user, you must be an IRISconsole administrator. Type

icpass -add icuser

The window shown in Figure 2-2 appears.

& ety At mni e stras o

Administrative prhlﬂe?es requirec.
Please enter your legin and password.

Password:

IRISconsole Login: I:[

||

Figure 2-2 Using the IRISconsole Security Window

Help Caneel

After you enter your IRISconsole login and password and click the Apply button, the
window shown in Figure 2-3 appears.

¥

Please enter the new user’s logln and password,
then click "Apply™ to add to the database.

IRISconsole Login:

Password:

Help Caneel

||

Figure 2-3 Adding an IRISconsole User

Enter the new user’s login and password. Note that they are independent of that user’s
system login and password. Click the Apply button.
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Determining Whether IRISconsole Security is On or Off

As described in the section “IRISconsole Security” in Chapter 1, IRISconsole can be used
to limit access to the capabilities of IRISconsole. To determine whether IRISconsole
security is on, type

icpass -security get

The software returns off or on.

Setting IRISconsole Security On or Off

To set IRISconsole security on or off, you must be an IRISconsole administrator. To set
IRISconsole security on, type

icpass -security set on

To set IRISconsole security off, type

icpass -security set off

In either case, the security window shown in Figure 2-2 appears. After you enter correct
information, a confirmation window appears with the message

Access Control status changed to ‘ON’

or

Access Control status changed to ‘OFF’

11
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Obtaining the Multiplexer SCSI ID Number and Serial Port Connections

In preparation for installing systems for IRISconsole, you need to obtain a SCSI ID and
port connections numbers by looking that the multiplexer and its cable connections.

Follow these steps:

1. Get the number of the SCSI ID used by the multiplexer. This number was set when
the IRISconsole system was installed and is displayed on the back of the
multiplexer, as shown in Figure 2-4.

SCSI ID
select switch

Figure 2-4 Checking the Multiplexer SCSI ID Number

2. Check the cabling for each system connected to the multiplexer to determine the
multiplexer port to which each system’s Remote System Control and System

Console ports are connected.

12
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If you want, create a table such as the example in Table 2-1 as an aid in determining
which serial ports are used for which servers.

Table 2-1 Example Table for Server Multiplexer Port Numbers

Server Hostname Multiplexer Port Number for Multiplexer Port Number for
Remote System Control System Control

jupiter 01 02

zeus 03 04

Setting Up IRISconsole for Remote Access

You can use the command ictelnet, which is a version of telnet adapted for IRISconsole, to
access the IRISconsole text-based menu from another system. Follow these steps to
prepare the IRISconsole system for remote access using ictelnet:

1. To configure a port on the IRISconsole system so that ictelnet communicates directly
to the IRISconsole application, edit the file /etc/services on that system to include the
following line, which specifies the port on which the service is available:

ictelnet 5000/tcp # IRISconsole Remote Access service

For the port number, use any number between 5000 and 5063; the number 5000 is
recommended for the status port.

2. Edit the file /etc/inetd.conf on the IRISconsole system to include this line:

ictelnet streamtcp  nowait root /usr/IRISconsole/bin/ictelnetd ictelnetd

13






Chapter 3

Configuring Sites

This chapter explains how to use the IRISconsole graphical user interface (GUI) to set up
a site, configure a site, edit a site configuration, add a system to a site, or delete a site
configuration. The major sections in this chapter are as follows:

= “Starting the IRISconsole Graphical User Interface” on page 15
< “Adding a Site” on page 17
< “Adding a System to a Site” on page 18

Starting the IRISconsole Graphical User Interface

The IRISconsole GUI main window enables you to set up a site, configure a site, edit a
site configuration, add a system to a site, or delete a site configuration.
To start the IRISconsole GUI, follow these steps:

1. Make sure the O2 or Indy workstation, multiplexer, and the Origin, CHALLENGE,
Onyx2, and Onyx systems to be administered are cabled as described in the
IRISconsole Multiplexer Installation Guide.

2. Make sure all systems are powered on.

3. The IRISconsole security feature is on by default; to check it or toggle it on or off,
follow instructions in the sections “Determining Whether IRISconsole Security is
On or Off” “Setting IRISconsole Security On or Off” in Chapter 2.

15
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4. To start the IRISconsole graphical user interface in an IRIX window, enter
ic

The IRISconsole GUI main window appears, as shown in Figure 3-1.

Figure 3-1 IRISconsole Graphical User Interface Main Window

To exit the IRISconsole GUI, select “Quit” in the File menu or press <Ctrl-Q>

16



Adding a Site

Adding a Site

To set up an IRISconsole site, follow these steps:

1.

In the Edit menu, select “Add New Site...” The Change IRISconsole Config dialog
box appears, as shown in Figure 3-2.

Enter site and press “Apply” to add, then double—elick
on the site icen to configure Its systems.

sopty || Resm || clese |

Figure 3-2 Change IRISconsole Config Dialog Box

In the Site field, type a name for the site.
Click the Apply button.

The name of the configuration file appears in the Config field; its name is based on
the system name; for example, /var/IRISconsole/.icrc.netwkl is the configuration file
for the site netwk1. The format of this filename—.icrc.sitetname— cannot be changed.

To save the new site configuration, select “Save IRISconsole Config” (or “Save
IRISconsole Config As...”) in the File menu in the main IRISconsole window.

To add another site, edit the entry in the Site field or click the Reset button to clear
the field. After you click the Apply button, the name of the new configuration file
appears automatically in the Config field. Save the new site configuration as in step
4.

When you are finished adding systems to the site, close the site window by clicking
the Close button.

To save the file, select “Save IRISconsole Config” (or “Save IRISconsole Config As”)
in the File menu. The file is saved to the IRISconsole directory /var/IRISconsole.

Click the Close button to exit the Change IRISconsole Config dialog box.

17
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Adding a System to a Site

To add a system to a site, follow these steps:

1. Inthe IRISconsole main window, double-click on the site to which you want to add
a system or select the system and select “Open Site...” in the Operations menu. The
site window opens, as shown in Figure 3-3.

i
2

Figure 3-3 Site Window

18



Adding a System to a Site

2. Inthe site window, select “Add New System...” in the Edit menu. If IRISconsole
security is on, you are prompted for your password.

After you enter your password, the Change Site Config dialog box appears, as
shown in Figure 3-4.

R —

A
e —
N —

Log Console Activity to File: [¥]
Default System Controller Password: [¥]

System Type:

If a port is not attached, enter "-1".

Figure 3-4 Change Site Config Dialog Box

3. Inthe System Name field, type the host hame of the system you want to add to this
site.

4. Inthe SCSI ID# field, enter the SCSI ID number of the multiplexer, as determined in
the section “Obtaining the Multiplexer SCSI ID Number and Serial Port
Connections” in Chapter 2.

5. Using the entries you made in a table similar to Table 2-1, enter the multiplexer port
numbers to which cables to the Console port and Remote System Control port are
connected in the Console Port# and Remote System Control Port# fields,
respectively.

19
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10.
11.

12.

13.

14.

In the Login field, enter the login under which all operations requiring access to the
system via the network can be performed. This login is the one used in the
command

rsh  login@ystem /usr/etc/sysctird -p

Note: The IRISconsole security login is separate from this system login; IRISconsole
security is explained in “IRISconsole Security” in Chapter 1.

In the Baud Rate field, enter the baud rate at which this system sends data to
IRISconsole; the default is 9600. If you enter a different baud rate, be sure that the
system has been configured for that rate.

Click the box at Log Console Activity to File if you want console activity logged to a
file in the /var/IRISconsole/logs/console_logs directory that has the format
systemname.<timestamp>.log. The format of this filename cannot be changed.

Note: To view a log of a system’s console activity (“Spy Console” button or
command) or to view console activity logs (“View Console Logs” button or
command), this box must be checked when the system is added to a site.

Click the box at Default System Controller Password if the system controller
password has the default value. This box applies only to Origin and Onyx2 systems.
If the system controller doesn’t have the default password, the operations Generate
NMI, HW Reset, and Power Cycle are not available; Connect SYSCTLR must be used
instead (see the section “Performing Operations on Attached Systems” in

Chapter 4).

Click on the System Type button and select the type of the system.

When you are satisfied with the settings for this system, click the Apply button to
add this system to the site.

To save the configuration, select “Save Site Config” (or “Save Site Config As...”) in
the site window File menu.

To add another system to the site, edit the entries in the fields of the Change Site
Config dialog box, or click the Reset button to clear all entries and begin entering
again. Follow instructions in steps 3 through 12 for the new system.

When you are finished adding systems to the site, close the Change Site Config
dialog box by clicking the Close button.
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Administering Sites

This chapter explains how to use the IRISconsole graphical user interface (GUI) and
IRISconsole commands to administer IRISconsole and the servers and other devices in
sites that it controls. The major sections in this chapter are as follows:

= “Administering IRISconsole Users and Administrators” on page 21
= “Connecting to a Remote IRISconsole Workstation on page 23
= “Viewing Site Characteristics” on page 26

« “Performing Operations on Attached Systems” on page 27

« “Using the Availability Monitor Report” on page 29

« “Displaying the System Log” on page 30

« “Displaying the Hardware Inventory of a System” on page 30
« “Displaying Hardware Status Information” on page 30

e “Using Alarms” on page 35

e “Using Graph Files” on page 37

« “Renaming or Deleting a Site” on page 39

= “Modifying or Deleting a System” on page 39

Administering IRISconsole Users and Administrators

The icpass command is used to listadministrators and users, change their passwords, and
delete them. Performing these tasks is described in the follow subsections. (Adding
administrators and users is described in the sections “Adding an IRISconsole
Administrator” and “Adding an IRISconsole User” in Chapter 2.)

21
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Displaying a List of IRISconsole Administrators or Users

To display a list of IRISconsole administrators, type

icpass -list icadmin

To display a list of IRISconsole users, type

icpass -list icuser

In each case, IRISconsole prints the path of the password file.

Changing the Administrator’s or User’s Password

To change an IRISconsole administrator’s or user’s password, type

icpass -change icuser

or

icpass -change icadmin

The window shown in Figure 4-1 appears.

Please enter your IRISconsole Login, and the
old and the new passwor
then click “Apply™ to add to the database.

IRlSzonsole Login: I:[
Qld Password: :[

R

Figure 4-1 Changing an IRISconsole Password

Enter the login for the user whose password you want to change. Enter the user’s old
password and new password, and click the Apply button.

22
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Deleting an Administrator or User

To delete an IRISconsole administrator or user, you must be an IRISconsole
administrator. Type

icpass -delete icadmin icadminlogin
or
icpass -delete icuser icuserlogin

The security window shown in Figure 2-2 appears. After you enter correct information,
a confirmation window appears with the message

Entry deleted from password database

Connecting to a Remote IRISconsole Workstation

You can use the command ictelnet to access the IRISconsole text-based menu from
another system. Follow these steps:

1. Ifyou haven’t already done so, configure the IRISconsole system for remote access.
Follow the instructions in the section “Setting Up IRISconsole for Remote Access” in
Chapter 2.

2. To use ictelnet from any system, type
ictelnet consolehostname 5000
The software prompts for your IRISconsole login and password.

3. Enter your IRISconsole login and password as they were entered with icpass -add
icuser or icpass -add icadmin; see “Adding an IRISconsole Administrator” in
Chapter 2 for details.

After a few lines of response, the available IRISconsole sites are listed, for example:

Main Menu:
Available Sites

Enter choice (1 - 3) or 'q’ to Quit:

23
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If a network connection from the remote host you are using to the IRISconsole
system is not available, you have two choices:

= log in to the IRISconsole system via modem and use ictelnet from there

= if you have a (modem) SLIP or PPP connection, you can run the IRISconsole
GUI remotely

4. Enter the number for the site to which you want to connect.

Text like the following appears:

Site 'engla’:
Available Systems

Enter choice (1 - 3) or ".." for Main Menu:
5. Enter the number for the system to which you want to connect.

The Available Operations menu appears, for example:

System ’engla’:
Available Operations

1. Connect to Console

2. Hardware Reset

3. Generate NMI

4. Power Cycle

5. Steal Occupied Console Line

Enter choice (1 - 5) or ..’ for Systems Menu:

Note: HW Reset, Generate NMI, and Power Cycle on an Origin or Onyx2 system
requires that the system controller have the default password.



Connecting to a Remote IRISconsole Workstation

10.

Enter the number for the operation you want to perform.
The following message appears:
This operation is protected.
Please enter your IRISconsole login and password.
IRISconsole Login:
Enter your IRISconsole login and password at the prompt.

Status and other information like the following appears:

9600 BAUD 8 NONE 1 SWFC=ON HWFC=0OFF
CAR=ON DTR=ON RTS=ON CTS=ON DSR=ON
Type ~? for Help, ~X to Exit.

Connection Ready.

Use the tilde commands ((+-)Baud Csize Dtr Framing Hwfc Info break Modem
Oflush Parity Rts Swfc eXit ) to change settings; you need not press <Enter> .

For example, ~S (note that this letter is uppercase) toggles software flow control and
displays a message similar to:

9600 BAUD 8 NONE 1 SWFC=0OFF HWFC=0OFF

FAYAYAYAYAYAYAVAN

To exit ictelnet, type ~X.

This command returns you to the Available Operations menu for the system that
was described in step 5 of this procedure.

From the Available Operations menu, type .. to exit to the Systems Menu, type ..
to exit to the Main Menu, then type q to exit to the IRIX prompt.
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Viewing Site Characteristics

To see characteristics for a site, double-click on its name in the scrolling list of sites in the
IRISconsole main window. Figure 4-2 shows an example main window.

Bl

1]

=
d
|=|
|
ol

Figure 4-2 Example IRISconsole Main Window

Alternatively, you can select a site and then select “Open Site...” in the IRISconsole main
window Operations menu. Figure 4-3 shows an example site window.
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datarray disarray

systems selected

Figure 4-3 Example IRISconsole Site Window

Performing Operations on Attached Systems

You can use the buttons in the site window (see Figure 4-3) for system administration
tasks. All but the HW Status button display a window in which you type your
IRISconsole login and password as it was entered in the IRISconsole security facility; see
“IRISconsole Security” in Chapter 1. The buttons are as follows:

Get Console To access and display a system’s console window, select the system and
click the Get Console button. The console window appears on the
workstation screen.

Generate NMI
To generate a non-maskable interrupt (forcing a panic in the operating
system), click the Generate NMI button.

Note: Generate NMI on an Origin or Onyx2 system requires that
system’s system controller have the default password.

HW Reset To reset a system in a site (hardware reset), select the system and click
the HW Reset button. A confirmation message appears.
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Power Cycle

Steal Console

Spy Console

Note: HW Reset on an Origin or Onyx2 system requires that system’s
system controller have the default password.

To power-cycle a system, or to power on a system that has been turned
off, select the system and click the Power Cycle button.

In the case of a power cycle, the system controller removes the power
enable control signals, waits five seconds, and restores power. Boot
arbitration is started after power is reapplied.

Note: Power Cycle on an Origin or Onyx2 system requires that system’s
system controller have the default password.

To take control of a system console that another user is currently using,
select the system and click the Steal Console button. The console window
appears on the workstation screen. The original user sees the message
IRISconsole DINC closing... ; that owner’s session is Killed.

To display a window showing console activity of a system in progress,
select the system and click the Spy Console button. In order to view this
activity, the “Log Console Activity to File” option must have been
checked when the system is added to a site, as explained in step 8 in
“Adding a System to a Site” in Chapter 3.

Show Console Logs

HW Status

To view console logs (stored in /var/IRISconsole/logs/console_logs/), select
the system and click the Show Console Logs button. In order for these logs
to be written, an IRISconsole user must be connected via the “Get
Console” command and the system must have been configured with the
“Log Console Activity to File” option checked, as explained in step 8 in
“Adding a System to a Site” in Chapter 3.

To display graphs of system activity, click the HW Status button. The
Hardware Status Monitor appears; this feature is explained in detail in
the section “Displaying Hardware Status Information” later in this
chapter. This feature requires a network connection between the O2 or
Indy host and the target system.

Connect SYSCTRL

To access and display a system’s system controller port window, select
the system and click the Connect SYSCTRL button. The system controller
window appears on the workstation screen. This is used primarily on
Origin and Onyx2 systems.



Using the Availability Monitor Report

Start Service Tool
To start the Service Tool, a tool intended for use by Silicon Graphics field
personnel, select a system and click the Start Service Tool button. A shell
window appears.

For each of these tasks, you can also select the corresponding command in the Operations
pulldown menu.

Using the Availability Monitor Report

The IRISconsole Availmon report gives a snapshot of availability information on a
system. It is a condensation of the information in /var/adm/avail/availlog, displayed in a
format similar to that of /var/adm/avail/amreport.

To display the Availmon report, follow these steps:

1. Make sure that availmon is installed and active on the Origin, CHALLENGE, Onyx2,
and Onyx systems you wish to access (use /etc/chkconfig).

2. Inthe site window, select the system for which you want a report.

3. Select “Availmon Report...” in the Monitor menu. A window like the example in
Figure 4-4 appears.

Figure 4-4 Example Availability Monitor Report
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Displaying the System Log

To display the SYSLOG for a system, select the system in the site window. Select “Show
Syslog...” in the Monitor menu.

To update the SYSLOG display, close the syslog window and select “Show Syslog...”
again.

Displaying the Hardware Inventory of a System

To display a hardware inventory of an attached system, select the system in the site
window and click “Hardware Inventory...” in the Monitor menu. The output of hinv for
that system appears in a window.

Displaying Hardware Status Information

Note: Hardware status information is not available for Origin or Onyx2 systems. This
section and its subsections do not apply to Origin or Onyx2 systems.

To display hardware operating information on a CHALLENGE or Onyx system in a site,
follow these steps:

1. Inthe IRISconsole main window, double-click on the site containing the system
whose hardware operating information you want to check. The site window
appears.

2. Inthe Systems scrolling list of the site window, select the system for which you want
information.

3. Click the HW Status button. The IRISconsole Hardware Status Monitor appears, as
shown in Figure 4-5.
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Figure 4-5 Example IRISconsole Hardware Status Monitor

The subsections below explain how to customize the Hardware Status Monitor display,
change the point and line styles for graphs, and use graph control panels for specific
graphs.

Customizing the Hardware Status Monitor Display

To change the height of a graph in the IRISconsole Hardware Status Monitor, put the
mouse cursor on one of the two sashes (small square at the extreme right between the
graphs) and drag it down or up; the relative heights of the graphs above and below it
change.

To zoom an area of the display, select the graph you want to zoom; holding down the
<Ctrl> key and pressing the middle mouse button, move the mouse. Press r to reset the

display.

You can further customize the display using choices in the Hardware Status Monitor
View pulldown menu. Figure 4-6 shows the View menu.
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View |

Display a log showing alarm thresholds that were exceeded —» i Alarms Log

& Voltage Graph

Turn specific graph displays off and on I: & Temperature Graph

o Blower Graph

Display legends that label the line types in the graph — LI Legends

Figure 4-6

Ctrl+V
Ctrl+T
Ctrl+B

View Pulldown Menu

Finally, you can use the Global Controls dialog box to customize the graph data. Select
“Global Controls...” in the Options pulldown menu; Figure 4-7 shows this dialog box.

For all graphs:
Set sampling rate for data —»

Set percentage of graph to scroll —»
back when limit'is reached

Set number of points —»
displayed onscreen
(amount of graph that is
offscreen to the left)

Run notify script —%
when threshold is exceeded

Sound beep or tone —»
when threshold is exceeded

Enter message in log file —»
when threshold is exceeded

Figure 4-7

Update Rate:

Scrollback %:

Data Density of All Graphs:

[ =] 25 (] Fastest
| I 1 =] 10 [ Optimize

50pts <> 100 pts <> 500 pts

[*1 Log to File:

Alarm Actions:

[ Bun Metify Script

¥ Sound Audible Alarm

4— Setto
fastest rate

<4— Optimize
scrollback

Global Controls Dialog Box

Changing Point or Line Styles for Graphs

To change the point or line style in a graph display, follow these steps:

Note: Style changes apply onscreen and for printing only; point and font style changes
are not saved when the graph is saved to a file.
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1.

In the Selected menu, select “Styles...” or click the Styles button in the Graph Control
dialog box. Figure 4-8 shows the Graph Style dialog box.

=" GFraph S

Set Polnt

S‘Dﬂ Set Line Style

Style: Style:
Nane Hone
- Dot Solid
L] Box = = = Long Dash
'y Triangle |[[| || Dottod
* Diamond ||| | [====== Short Da=sl
+ Star === TSL Dash
==+ Dash Dot
Color Colo:
size: [ & width: 2] 4
Selected:

= |

ey e

Graph Style Dialog Box

In the Hardware Status Monitor, click the left mouse button on the graph whose
style you want to change. The graph background turns yellow.

Put the mouse cursor on the line whose style you want to change and click the right

Note: To facilitate selecting a line, zoom the display by holding down the <Ctrl>
key, pressing the middle mouse button, and moving the mouse. To reset the display,

In the Graph Style dialog box, select the point or line style you want and click the
Apply button to save the setting.

Figure 4-8

2.

3.
mouse button.
typer.

4,

5.

When you are satisfied with the settings, click the Close button to exit the Graph

Style dialog box.
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Using Graph Control Panels for Specific Graphs
A graph control panel is associated with each graph. To display the control panel for a
graph, follow these steps:

1. Inthe Hardware Status Monitor, select the graph for which you want to display a
control panel. The graph background turns yellow.

2. Inthe Selected menu, select “Graph Controls...” Figure 4-9 shows the graph control
panel for blower speed(s).

—|| Graph Controf Panel
Blower Speed Graph
Determine whether the selected graph displays live data [ Live Data Feed
Set data density for the selected graph — Data Density: [T (0m [m=] 50

Set high and low threshold values for an alarm Alarm Thresholds:

High: | |EB0.8 |

Low: |15aa.a |

Display Global Controls dialog box —{[Giobals .| [ Shiese | [FaieasGrann |
| Cearslam || Prinl.. | [[SaeAsPs.. ||

Figure 4-9 Graph Control Panel for Blower Speed

Use features of this panel to
= setan alarm threshold, as described in “Using Alarms,” later in this chapter

= set actions to be performed if the threshold is exceeded, as described in “Using
Alarms,” later in this chapter

e clearanalarm

= change the point and line style of the graphs, as described in “Changing Point or
Line Styles for Graphs,” earlier in this chapter

= print the graphs, as described in “Saving Graph Data to a File,” later in this chapter

= save the graphs as graphs or PostScript® files, as described in “Printing a Graph,”
later in this chapter



Using Alarms

Using Alarms

Note: Alarms are not available for Origin or Onyx2 systems. This section and its
subsections do not apply to Origin or Onyx2 systems.

You can set a threshold value for a hardware operating parameter, such as blower speed.
When the value is exceeded, the graph that maps it changes color to alert you that the
threshold has been exceeded and its contents are saved to a file. You can also set
IRISconsole to perform any of the following actions when the threshold is exceeded:

= cause a beep or tone to be sounded

< enter a message in an alarms log file in the directory /var/IR1Sconsole/logs; the default
filename is alarms.log

= start a notify script

For example, you can set the operating temperature threshold for a CHALLENGE XL in
asite to 37, so that when the system internal temperature exceeds 37 degrees C, the alarm
is triggered.

This section explains

« setting a threshold for an alarm

e clearing an alarm

= viewing an alarm graph file

= using a notify script

Setting a Threshold for an Alarm

To set a threshold, follow these steps:

1. Select the graph for which you want to set an alarm threshold. The graph
background turns yellow.

2. Inthe Selected menu, choose “Graph Controls...” The Graph Control Panel appears;
Figure 4-10 shows the panel for the Temperature graph.
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Temperature Graph
[ Live Data Feed
Data Density: [ T ] 50

Alarm Thresholds:

High: [B8

Low: |28.8

Figure 4-10 Graph Control Panel for Temperature

3. If desired, change the data density (number of points) of the data being sampled.

4. Select the high and low alarm threshold values you want from the choices in the
High and Low fields.

5. If desired, select one or more alarm actions in the Global Controls window.
When the threshold value is reached or exceeded, the graph display turns hot pink when

unselected (bright red when selected).

Clearing an Alarm

To clear an alarm, select the graph whose alarm you want to clear and click the Clear
Alarm button in the Graph Control panel, or select “Clear Alarm” in the Selected menu.
To clear all alarms, select “Clear All Alarms” in the Options menu.



Using Graph Files

Using Graph Files

Viewing an Alarm Graph File

When a threshold is exceeded, the graph for which the alarm is set is automatically saved
to a file in the directory /var/IRISconsole/logs/alarms. The filename has the format
graphname.<timestamp>.xrt; for example, voltage.951231.1144.0.xrt.

You can view alarm graph files by selecting “Display Saved Graph...” in the IRISconsole
Hardware Status Monitor File menu; see “Displaying a Graph File,” later in this chapter.

Using a Notify Script

An option in the Global Controls window enables IRISconsole to run a script—
/var/IR1Sconsole/adm/scripts/icnotify.tclX—when an alarm threshold is exceeded. This
script, which was written in tclX (extended tcl), is self-documenting.

To edit this script, select “Edit Operator Notify Script” in the main window Options
window. You must be root to edit this script.

For example, to cause an alarm threshold to send an e-mail message to a specified user,
enter e-mail address(es) in the curly braces in the line

set OPERATORS {}

You can edit icnotify.tclX to include other scripts.

Note: Graph files are not available for Origin or Onyx2 systems. This section and its
subsections do not apply to Origin or Onyx2 systems.

You can save, display, and print graph data for CHALLENGE and Onyx systems in files

in either PostScript or image form. The subsections below describe how to perform these
operations.
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Saving Graph Data to a File

You can save a graph to a PostScript file or image file to send to service personnel, or to
compare with other graph data saved to files.

To save a graph to a PostScript file, click the Save As PS... button in the Graph Control
panel. Enter a filename and click the Save button to save the file and exit the dialog box.
To save a graph to an image file, follow these steps:

1. Freeze the data by clicking the Live Data Feed checkbox off in the Graph Control
panel (see Figure 4-9 or Figure 4-10). The scroll bars under the graphs are activated.

2. Click the Save As Graph button in the Graph Control panel. A file selection dialog
box appears, as shown in Figure 4-11.

Figure 4-11 Saving a Graph File
If desired, click the Filter button to display a dialog box in which you can exclude
filename patterns to restrict the filenames displayed.

3. Enter afilename for the graph file in the Selection field.

4. Click the Save button to save the file and exit the dialog box.



Renaming or Deleting a Site

Displaying a Graph File

You can display the saved graph in IRISconsole by selecting “Display Saved Graph...” in
the IRISconsole Hardware Status Monitor File menu. A dialog box similar to that shown
in Figure 4-11 appears, in which you select the file to display. Files saved as graphs
appear when they are selected.

To display files saved as PostScript files, use your PostScript viewer.

Printing a Graph

You can print a PostScript graph file just as you would print any other PostScript file.
You can also printa graph as itis displayed in the Hardware Status Monitor. Follow these
steps:

1. Inthe Hardware Status Monitor, select the graph you want.

2. If desired, change the dimensions of the graph by moving a sash (small square at the
extreme right between the graphs).

3. If desired, select an area of the display by holding down the <Ctrl> key and
pressing the left mouse button; zoom the selection by moving the middle mouse
button. (Press r to reset the display.)

4. When the screen displays the graph as you want it to be printed, click the Print
button. In the Print dialog box, select the print options you want.

Renaming or Deleting a Site

You can rename or delete a site using choices in the IRISconsole main window Edit menu.

Modifying or Deleting a System

If your hardware configuration changes, use “Modify System Config...” in the site
window Edit menu to change the parameters for a system in a site.

To delete a system from a site, select it in the site window and choose “Delete Selected”
in the Edit menu.
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Appendix A

Error Messages and Warning Messages

This appendix lists error messages that can appear during operation of IRISconsole. It
interprets each error message and suggests solutions. The messages are listed in
alphabetical order.
<name> is a directory
You selected a directory to save into, when a file was expected.
A site edit session is in progress.
Finish that before opening.
It is not possible to open a site while its configuration information is being
edited. Finish the editing first.
Cannot create directory <name>
Cannot create directory; permissions on /var/IRISconsole should be writable by
the user.
Cannot edit multiple configurations.
You have selected more than one site or system. Select one site or system at a time
to edit.
Caution: Baud rate of a Challenge machine is typically 9600.
Make sure that it is configured to handle this rate.

A legal value other than 9600 was entered in the Baud Rate: field of the Change
Site Config dialog box. Although the baud rate can range from 300 to 115,200,
any rate other than the default rate of 9600 needs configuration changes in the
managed server to accept that rate. Note that this messages is a warning and not
an error message.
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Couldn’t find an ST-1600 attached to SCSI bus.

IRISconsole couldn’t detect any multiplexers that should have been attached to
a SCSI port on the back of the O2 or Indy workstation. Follow these steps:

1.

Check the SCSI target ID on the back of the multiplexer; make sure that it
does not conflict with any other external devices that are attached. Do not
use the settings 0 or 1.

Check the connections of the SCSI cable between the multiplexer and the
02 or Indy SCSI port. Use the High Density SCSI-2.cable supplied with the
multiplexer or another cable meeting specifications outlined in the
Technical Specifications chapter of the IRISconsole Multiplexer Installation
Guide.

After checking and, if necessary, reseating connectors, ask IRISconsole to
rescan by selecting “Show SCSI Bus Attachments” in the Options menu of
the main IRISconsole window. This action displays the SCSI I1Ds of all
multiplexers that IRISconsole finds.

Error in getting Hardware Inventory.
Either the target system could not be reached, or
it's refusing service to the Login '<login>’

You tried to run hinv on a system in a site. Either the target system could not be
reached, or it is refusing service to your login. Follow these steps:

1.

Check the network connection with the target system (ping or another
command as appropriate).

Check the login you have entered for that system: select the system and
choose “Modify System Config” in the Edit menu of the site window.

Make sure that the login you entered has permission to perform a remote
operation by typing

rsh  login@ystem hinv

If necessary, correct the login (or get its permissions changed) and retry the
command above.

Error in ST-1600 software installation
Couldn't find /shin/cdscanbus

The multiplexer software subsystem has not been installed. Install it from the
distribution CD.
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Failed to create config file
You have attempted to create a new site. Check the permissions on
/var/IRISconsole to see if it is writable for your login.

Failed to fetch /var/adm/SYSLOG: <reason>
The system has probably refused service to your login. Follow these steps:

1. Check the login you have entered for that system: select the system and
choose “Modify System Config” in the Edit menu of the site window.

2. Make sure that the login you entered has permission to perform the
operation by typing

rsh  login@ystem tail /var/adm/SYSLOG
If necessary, correct the login (or get its permissions changed) and retry the
command above.
Failed to write to file
Your attempt to save the configuration file failed. Check permissions on
/var/IRISconsole/.icrc.sitename to see if it is writable for your login.
Invalid baud rate:
Should be between 300 and 115200.
An inappropriate baud rate was entered. Baud rates can range between 300 and
115200.
Invalid field value <value>
The value you entered in this field of the Change Site Config dialog box is
invalid; try again.
Invalid System Console port number
Invalid Remote System Control port number
Multiplexer port numbers may range only from decimal 1 to 16.
Must select a site.
Must select a system.

An attempt was made to perform an operation on a site or system without
actually selecting it. Single-click on the desired site or system first and try the
action again.
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No Availability Monitor information to report.
Either <system> doesn’t have an ‘availmon’ running, or
it's refusing service to the Login <login>

Either the currently selected doesn’t have an availmon running, or it is refusing
service to your login. Check the login you have entered for that system: select the
system and choose “Modify System Config” in the Edit menu of the site window.
If necessary, correct the login (or get its permissions changed) and retry the
operation.

The System Availability Monitoring Facility (availmon) is included in the eoe2.sw
subsystem and must be installed on the Origin, CHALLENGE, or Onyx server.
After it is installed, activate it by typing

/etc/chkconfig avail on

No icons may be dropped into this panel.

This version of IRISconsole does not support drag and drop behaviors on icons.
The icon(s) dropped will automatically be repositioned at their original
locations.

No Remote System Control information to report.
Either <system> doesn’t have a ‘sysctlrd’ running, or
it's refusing service to the Login <login>

Either the currently selected system doesn’t have a sysctlrd running, or it is
refusing service to your login.

If the connected system isa CHALLENGE S, you cannot perform the action you
tried; this type of server has no system controller, which is required for this
action.

For other connected systems, follow these steps:

1. Check the login you have entered for that system: select the system and
choose “Modify System Config” in the Edit menu of the site window.

2. Make sure that the login you entered has permission to perform the
operation by typing

rsh  login@ystem /usr/etc/sysctlrd -p

If necessary, correct the login (or get its permissions changed) and retry the
command above.



Nothing selected.
You have specified an action for which a site or system must be selected. Select
the item and try the action again.

Null input values aren’t allowed.

Spaces not allowed in fields.
Enter a valid value in the field.

Null site name.

Null system name.
An attempt was made to create a site or system with a “null” name. Names must
have at least one character and may not contain spaces.

Please close following site(s) before deleting
You attempted to delete a set of sites when a subset of it was still open. Close the
site(s) and try the action again.

Port number must be between 1 and 16.

Multiplexer port numbers may range only from decimal 1 to 16.

Rename not allowed when site is open.

An attempt was made to rename a site that is already open. Close the site first.

SCSI ID must be between 2 and 7.

Inspect the back of the multiplexer for the SCSI target ID used. To verify that the
multiplexer is installed properly, select “Show SCSI Bus Attachments” in the
Options menu of the main IRISconsole window and check the SCSI ID displayed
in the dialog box.

Site is already open.
An attempt was made to open a site that is already open. The site window
appears at the top of the stack of windows.

Site name already exists.

Select it, then “Edit” its configuration.

An attempt was made to create a site that exists already. Create a unique site with
a new name. To change the configuration of an existing site, select it first.
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Spaces not allowed in fields.

Enter a valid value in the field.

System name already exists.
Select it, then “Edit” its configuration.

An attempt was made to create a system that exists already. Create a unique
system with a new name. To change the configuration of an existing system,
select it first.

/usr/sbin/sysmon not installed.

sysmon.sw, included in the base IRIX release, is a GUI-based tool for analyzing
system logs. Install this system from the IRIX 6.2 (Indy) or IRIX 6.3 (O2) CD for
this feature to function.

You must have eoe.sw.uucp installed.

IRISconsole uses uucp-style locking on device nodes. Install this subsystem from
the IRIX 6.2 (Indy) or IRIX 6.3 (O2) CD.
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Tell Us About This Manual

As a user of Silicon Graphics products, you can help us to better understand your needs
and to improve the quality of our documentation.
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Technical errors

Relevance of the material to the job you had to do

Quiality of the printing and binding

Please send the title and part number of the document with your comments. The part
number for this document is 007-2872-002.

Thank you!
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To send your comments by electronic mail, use either of these addresses:
— On the Internet: techpubs@sgi.com
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To fax your comments (or annotated copies of manual pages), use this
fax number: 415-965-0964

To send your comments by traditional mail, use this address:
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Silicon Graphics, Inc.

2011 North Shoreline Boulevard, M/S 535
Mountain View, California 94043-1389



